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Introduction

This document is intended for use with IBM® Cognos® TM1®.

It provides the information you need to perform a basic installation on a single
computer that uses the Microsoft Windows operating system.

Audience

To use this guide, you should be familiar with:
v Basic database concepts
v Basic Windows operating system administration
v Web server configuration

Finding information

To find IBM Cognos product documentation on the web, including all translated
documentation, access one of the IBM Cognos Information Centers
(http://publib.boulder.ibm.com/infocenter/cogic/v1r0m0/index.jsp). Release
Notes are published directly to Information Centers, and include links to the latest
technotes and APARs.

Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products. This product
has accessibility features. For information on these features, see “Accessibility
features,” on page 13.

Samples disclaimer

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors
name, and Planning Sample depict fictitious business operations with sample data
used to develop sample applications for IBM and IBM customers. These fictitious
records include sample data for sales transactions, product distribution, finance,
and human resources. Any resemblance to actual names, addresses, contact
numbers, or transaction values is coincidental. Other sample files may contain
fictional data manually or machine generated, factual data compiled from
academic or public sources, or data used with permission of the copyright holder,
for use as sample data to develop sample applications. Product names referenced
may be the trademarks of their respective owners. Unauthorized duplication is
prohibited.

Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.

© Copyright IBM Corp. 2012 v
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Chapter 1. What's new for Cognos TM1 installation and
configuration in 10.1.1

This section contains a list of new, changed, and removed features for this release.

There were no significant changes to the installation procedures described in this
manual in the IBM Cognos TM1 10.1.1 release. Some corrections and expansions
were made to the information provided here. See the "What’s New" chapter in the
IBM Cognos TM1 Operations Console Guide for details on new features added to the
Cognos TM1 Operations Console in this release.

To locate the most current product documentation, go to the IBM Cognos TM1
10.1.0 Information Center (http://publib.boulder.ibm.com/infocenter/ctm1/
v10r1m0/index.jsp).

To review an up-to-date list of environments supported by IBM Cognos products,
such as operating systems, patches, browsers, web servers, directory servers,
database servers, and application servers, visit the Cognos Customer Center
(http://www.ibm.com/software/data/support/cognos_crc.html).
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Chapter 2. Cognos TM1 single-computer installation

This type of installation puts IBM Cognos TM1 on a single computer running the
Microsoft Windows operating system and using default settings. Use this kind of
installation to get up and running quickly with Cognos TM1 or to install a test or
evaluation environment.

To configure and install the full features and optional components of Cognos TM1,
see the comprehensive IBM Cognos TM1 Installation and Configuration Guide found
on the IBM Cognos Information Center (http://publib.boulder.ibm.com/
infocenter/cogic/v1r0m0/index.jsp).

The single computer installation explains how to install and run:
v Cognos TM1 Admin Server
v Cognos TM1 Server
v Cognos TM1 Perspectives
v Cognos TM1 Architect
v Cognos TM1 Web
v Cognos TM1 Application Server
v Cognos TM1 Application Web
v Cognos Insight
v Cognos TM1 Performance Modeler

This installation scenario assumes:
v You are on a single 32- or 64-bit computer running the Microsoft Windows

operating system.
v You use the Apache Tomcat web server software installed by the Cognos TM1

installation.
v You use the default, standard Cognos TM1 authentication.
v You accept the default configurations including English as the language.

Not all Cognos TM1 components are available for 64-bit systems. If the component
is available as a 64-bit installation, it is installed in a directory identified as a 64-bit
location instead of in the default 32-bit installation directory location. For example,
bin64 instead of bin.

Remember: Your browser may use a slightly different interface than the browser
used in the steps described here.

Install the prerequisite software
You need the prerequisite software before you install IBM Cognos TM1.

About this task

If you do not have these prerequisites in place, the Cognos TM1 Installation wizard
tries to install them for you, however the wizard can install only one at a time. If
you are missing more than one, you may need to restart the install until you have
them all. You may already have this software installed.
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Procedure
1. For Cognos TM1 Perspectives or Cognos TM1 Architect, install or confirm that

you have:
v Microsoft .NET Framework 3.5 Service Pack 1
v Microsoft Visual C++ 2005 SP1 Redistributable Package
v Microsoft Excel

2. For Cognos TM1 Web or Cognos TM1 Application Server, install or confirm
that you have:
v Microsoft .NET Framework 3.5 Service Pack 1
v Microsoft Chart Controls for Microsoft .NET Framework 3.5
v Microsoft Internet Information Services (IIS) web server software.
On Windows 7, Windows XP, and Windows Server 2008 operating systems,
ensure that the IIS 6 Management Compatibility option is enabled. Without this
setting, Cognos TM1 Web cannot create the virtual directories it needs. Search
the Microsoft support website for “IIS 6 Management Compatibility” for more
details.
See Cognos TM1 10.1.0 Software Environments (www.ibm.com/support/
docview.wss?uid=swg27021976) for the latest information about prerequisite
software.

3. Cognos Insight and Cognos TM1 Performance Modeler can both be launched
from the Cognos TM1 Applications portal, so you must install and be able to
run Cognos TM1 Applications before you can launch Cognos Insight or Cognos
TM1 Performance Modeler from that portal.

Install the basic Cognos TM1 components
Use the installation program to select the components you want to install and the
location on your computer where you want to install them.

Before you begin
v Ensure that you have administrator privileges for the computer on which you

are installing software.
v Ensure that the computer has a TEMP system variable that points to the

directory where you want to store temporary files. During installation, files are
temporarily copied to this directory.

v Some Microsoft Windows web server software does not support non-ASCII
characters in directory names. Ensure that the directories where you install IBM
Cognos TM1 components contain only ASCII characters in the path name.

v Ensure that all of the prerequisite software has been installed.
v There are several varieties of installation program available to you. Depending

on which operating system you are using, go to the directory where the one you
want to install is stored:
– TM1 for 32-bit Windows
– TM1 for 64-bit Windows

Procedure
1. To start the installation:

v Go to the download location for the Cognos TM1 installation program that
you want to use.

v Or, insert the IBM Cognos TM1 product disk.
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If the installation wizard does not open automatically, go to the operating
system directory to locate the issetup.exe command.

2. Depending on your operating system software, right-click or double-click the
issetup.exe file:
v On Microsoft Windows Vista, Windows 7, or Windows Server 2008 operating

system software, right-click the issetup.exe file and click Run as
Administrator.

v For all other Windows operating system software, double-click issetup.exe.

3. Follow the directions in the installation wizard to select all of the components.
The components that you need to run the software are selected by default.
If you do not want to install Cognos Insight or Cognos TM1 Performance
Modeler, skip to Step 5.

4. To include Cognos Insight in the installation, expand the TM1 Client Tier and
the select Cognos Insight.

5. To include Cognos TM1 Performance Modeler in the installation, expand the
TM1 Developer Tier and select TM1 Performance Modeler.

6. Click Next until the installation begins.
The installation runs until all components have been installed. This may take a
significant amount of time.

Tip: For earlier Windows operating systems, you can check Start Cognos
Configuration on the last screen of the installation to immediately run the
configuration tool. On Microsoft Windows Vista, Windows 7, or Windows
Server 2008 operating system software, do not check that box and instead use
the Start menu so you can choose Run as Administrator when launching the
Cognos Configuration tool.

7. Click Finish.

Use Cognos Configuration to start the Cognos TM1 components
Before you can use Cognos TM1, you need to start the IBM Cognos TM1 Admin
Server, the TM1 Excel service, the TM1 Application Server, and at least one IBM
Cognos TM1 sample database server. This action registers the servers in the
Windows service restry. Then you need to configure the services so that they run
under a specific user. Servers that are running in a Microsoft Windows
environment are referred to as “services.”

Procedure
1. If it is not already running, start the configuration tool by clicking Start > All

Programs > IBM Cognos TM1 > IBM Cognos Configuration.

Remember: Right-click and use Run as Administrator on Windows Vista,
Windows 7, and Windows Server 2008 operating system software.

2. In the Cognos Configuration Explorer pane, expand Local Configuration >
Environment.

3. Right-click each server that you want to start and select Start:
a. TM1 Admin Server It is best to start the TM1 Admin Server first since that

server must be running before any sample database can run.
The Cognos Configuration tool prompts you to save any edits made to the
configuration settings. This process will take longer the first time you save a
setting as the cryptographic settings and other actions take place for the

Chapter 2. Cognos TM1 single-computer installation 5



first time. Click Yes in response to the message asking you to save the
settings. You will also see this type of message when you close Cognos
Configuration.

b. TM1 Excel service

c. TM1 Application Server

4. Expand the Data Access > TM1 Server node and right-click each Cognos TM1
sample database server that you want to start and select Start. For example,
start the provided sample databases:
a. SData

b. Planning Sample

c. GO_New_Stores

5. Click File > Save.
6. Now that the services are all registered in the Windows services registry, you

can reconfigure them to use a specific user account:
a. In Cognos Configuration, right-click each service you want to change and

select Stop.
b. Open Windows Services.
c. Right-click on each service and select Properties.
d. Enter a user name and password valid on your system with the appropriate

rights for the service. See “User accounts for running Cognos TM1 services
on Windows” in the “Planning” chapter of the IBM Cognos TM1 Installation
and Configuration Guide for details about the rights that this user account
should have.

e. Close Windows Services.
7. In Cognos Configuration, right-click each server and select Start.
8. Close Cognos Configuration.

Run Cognos TM1 Perspectives
After installation, you can run IBM Cognos TM1 Perspectives.

Procedure
1. From the Windows Start menu, click IBM Cognos TM1 > Perspectives. If the

component does not start, ensure that the servers you started with Cognos
Configuration are still running.

2. Click Enable Macros when the security warning displays.
3. Click TM1 > Server Explorer, then expand TM1 to see the servers that are

available.
4. Double-click a Cognos TM1 Server to log in.

For SData, Planning Sample, or GO_New_Stores use these login credentials:
v User name: admin

v Password: apple

Tip: To load Cognos TM1 Perspectives automatically whenever you start
Microsoft Excel, add TM1_location/Tm1p.xla to Microsoft Excel's add-in tool
list, where TM1_location is the file directory where Cognos TM1 is installed.
After completing this step, "TM1" displays on the Microsoft Excel menu bar.
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Run Cognos TM1 Architect
After installation, you can run the non-Microsoft Excel version of IBM Cognos TM1
called IBM Cognos TM1 Architect.

Procedure
1. From the Windows Start click All Programs > IBM Cognos TM1 > Architect.

If Cognos TM1 Architect does not start up, ensure that the servers you started
with Cognos Configuration are still running.

2. Expand TM1 to see the servers that are available.
3. Double-click a Cognos TM1 Server to log in.
4. Use these credentials to log into the SData, Planning Sample, or

GO_New_Stores sample databases:
v User name: admin

v Password: apple

Run Cognos TM1 Web
The IBM Cognos TM1 installation configures IBM Cognos TM1 Web to run with
your existing installation of Microsoft Internet Information Services (IIS) web
server software.

Before you begin

Keep in mind the following information when using TM1 Web:
v On Windows 7, Windows XP, and Windows Server 2008 operating systems,

ensure that the IIS 6 Management Compatibility option is enabled. Without this
setting, Cognos TM1 Web cannot create the virtual directories it needs. Search
the Microsoft support website for “IIS 6 Management Compatibility” for more
details.

v See “Changing Cognos TM1 services to run as a specific user account on
Windows” in the “Cognos TM1 Web installation” chapter of the IBM Cognos
TM1 Installation and Configuration Guide for details on how to configure the TM1
Excel Service to run as a specific user.

Procedure
1. In a web browser, enter the following URL: http://localhost/tm1web

You can use the “localhost” term to make the computer location default to use
your current computer. Or you can explicitly enter the IP address or name for
the computer where you installed Cognos TM1.

2. Depending on what other components you have launched, the Log In box
values will usually be automatically entered for you. If they are not, you can
enter or change those values as needed.

3. Click Log In.

Note: Your anti-virus software may prompt you when the Cognos TM1 Excel
service attempts to log into the web. Follow your company guidelines for
security. Cognos TM1 Web requires access to the web so a setting such as
Permit Always is optimal for all your Cognos TM1 services.
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Run the Cognos TM1 Applications portal
IBM Cognos TM1 Applications is the web-based client and portal used to run
planning applications built using IBM Cognos TM1 data.

About this task

Cognos TM1 Applications is also used to launch IBM Cognos TM1 Performance
Modeler and can be used to launch IBM Cognos Insight.

Procedure
1. In a web browser, enter the following URL: http://localhost:9510/pmpsvc

where 9510 is the usual port used by Cognos TM1 Application Server. If you
used a different port when you installed, enter that other value here.

2. Accept the defaults for all of the configuration settings to identify the Admin
Host, server, types of clients, and the URL used by the Cognos TM1
Applications Server.

3. Click OK.
4. Enter admin and apple for the username and password for the sample

database servers.
5. To complete the installation, dismiss the message about editing the

AllowSeparateNandCRules and DistributedPlanningOutputDir parameters in the
tm1s.cfg files.
You do not need to edit those parameters until you begin working with the
clients.
The portal is empty until you build an application using Cognos TM1
Performance Modeler or import an existing application.

Run Cognos Insight
IBM Cognos Insight is available as an unselected component of the IBM Cognos
TM1 installation. Cognos Insight can be used as a client for contributing to
applications and also as a dynamic workspace builder for creating interactive
contributing user experiences.

Procedure
1. To run Cognos Insight, complete one of the following actions:

v From the Cognos TM1 Applications portal, click the icon.
Or you can:

v Right-click a node of an application that has been configured to use Cognos
Insight.

v You can also click the Cognos Insight desktop icon that gets installed.
v Cognos Insight can also be installed as a stand-alone component.

Remember: Depending on your browser, you may see slightly different steps
used to install downloaded components such as Cognos Insight.

2. Click OK with the Open With IBM Cognos RCP Application Updater selected
on the provagent.cogrcp_insight dialog box.

3. If you see an Executable file warning, click OK to proceed with the installation.
4. Click OK to dismiss the AllowSeparateNandCRules and

DistributedPlanningOutputDir configuration setting message.
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You do not need to edit those parameters until you begin working with the
clients.
See the IBM Cognos Insight User Guide on the TM1 10.1.0 Information Center
(http://publib.boulder.ibm.com/infocenter/ctm1/v10r1m0/index.jsp) for
details about creating Cognos Insight workspaces and using Cognos Insight as
a client for contributing to applications.

Run Cognos TM1 Performance Modeler
IBM Cognos TM1 Performance Modeler is available as an unselected component of
the IBM Cognos TM1 installation. You launch Cognos TM1 Performance Modeler
from the IBM Cognos TM1 Applications portal.

Procedure
1. From the Cognos TM1 Applications portal, click the Open Performance

Modeler icon.

Remember: Depending on your browser, you may see slightly different steps
used to install downloaded components such as Cognos TM1 Performance
Modeler.

2. Click OK with the Open with IBM Cognos RCP Application Updater selected
on the provagent.cogrcp_modeler dialog box.

3. Click OK to dismiss the configuration settings message and complete the
installation.
You do not need to edit those parameters until you begin working with the
clients.

4. Click the Model Design tab to see the GO_New_Stores data cubes and
structure.

5. Click the Application Design tab to build a new application using
GO_New_Stores.
See the IBM Cognos TM1 Performance Modeler User Guide found on the TM1
10.1.0 Information Center(http://publib.boulder.ibm.com/infocenter/ctm1/
v10r1m0/index.jsp) for details on using the Cognos TM1 Performance Modeler
to design and build applications.

Use Cognos TM1 Application Web
The IBM Cognos TM1 Application Web is a web-based client used to contribute to
planning applications and to work with IBM Cognos TM1 Websheets.

Before you begin

You need a planning application before you can use the Cognos TM1 Application
Web client. The application designer identifies which clients can be used with a
particular application.

Tip: You can see which clients the designer made available for an application by
right-clicking a node of the application when it is displayed in the IBM Cognos
TM1 Applications portal.

Procedure
1. In the Cognos TM1 Applications portal, right-click a node in a planning

application.
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2. Select TM1 Contributor client to launch the Cognos TM1 Application Web
client.
See the IBM Cognos TM1 Applications Guide found on the Cognos TM1 10.1.0
Information Center (http://publib.boulder.ibm.com/infocenter/ctm1/v10r1m0/
index.jsp) for details on how to contribute to an application using the Cognos
TM1 Application Web client.
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Chapter 3. Other Cognos TM1 components

The IBM Cognos TM1 installation makes many other components available and
has many other ways to customize the installation.

See the following guides for details about other ways to install and configure
Cognos TM1:
v The IBM Cognos TM1 Operations Console is a tool used by administrators to

monitor the activity of TM1 servers on the network. See the IBM Cognos TM1
Operations Console Guide for more information.

v IBM Cognos TM1 Viewer Portlets are used when accessing data Cognos 8 data
sources. See the IBM Cognos TM1 Operation Guide for more information.

v The IBM Cognos TM1 Package Connector is used to import IBM Cognos
Framework Manager packages. See the IBM Cognos TM1 TurboIntegrator Guide
for more information.

See the comprehensive IBM Cognos TMI Installation and Configuration Guide for
details on these additional components and on other ways to install Cognos TM1.
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Appendix. Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products.

See the IBM Accessibility Center for more information about the commitment that
IBM has to accessibility.

The IBM Accessibility Center is available online at http://www.ibm.com/able.

Keyboard shortcuts for the installation wizard
Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster
method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system
navigation keys in addition to application-specific keys.

Note: The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some
of the main tasks in the installation wizard on the Windows operating system.

Action Shortcut key

Move to the next field on a page Tab

Return to the previous field on a page Shift+Tab

Close the installation wizard Alt+F4

Move to the next configuration step Alt+N

Return to the previous configuration step Alt+B

Move to the next selection in a list Down arrow

Move to the previous selection in a list Up arrow

The following table lists the keyboard shortcuts you can use to perform some of
the main tasks in the installation wizard on the UNIX or Linux operating system.

Action Shortcut key

Move to the next field on a page Tab

Return to the previous field on a page Shift+Tab

Close the installation wizard Alt+F4

Move to the next selection in a list Down arrow

Move to the previous selection in a list Up arrow

The following table lists the keyboard shortcuts you can use to perform some of
the main tasks in the License Agreement page of the installation wizard.

Action Shortcut key

Accept the license agreement Alt+A
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Action Shortcut key

Decline the license agreement Alt+D

Quit the installation wizard Alt+x

Keyboard shortcuts for Cognos Configuration
Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster
method of navigating and using software.

The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some
of the main tasks in IBM Cognos Configuration on the Windows operating system.

Action Shortcut key

Save the current configuration Crtl+S

Close Cognos Configuration Alt+F4

Rename the selected item F2

Display the File menu Alt+F

Display the Edit menuAlt+H Alt+E

Display the View menu Alt+V

Display the Actions menu Alt+A

Display the Help menu Alt+H

The following table lists the keyboard shortcuts you can use to perform some of
the main tasks in Cognos Configuration on the UNIX or Linux operating system.

Action Shortcut key

Save the current configuration Tab

Close Cognos Configuration Shift+Tab

Rename the selected item Alt+F4
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Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Trademarks

IBM, the IBM logo, ibm.com, TM1, and Cognos are trademarks or registered
trademarks of International Business Machines Corp., registered in many
jurisdictions worldwide. Other product and service names might be trademarks of
IBM or other companies. A current list of IBM trademarks is available on the Web
at “ Copyright and trademark information ” at www.ibm.com/legal/
copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
v Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered

trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

v Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

v UNIX is a registered trademark of The Open Group in the United States and
other countries.

v Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Microsoft product screen shot(s) used with permission from Microsoft.
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